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1. Welcome  
 
Technical precautions   
This equipment generates radio frequency energy and if not installed in accordance with the 
manufacturer’s instructions, may cause radio frequency interference.   
This equipment complies with Part 15, Subpart J of the FCC rules for a Class A computing device. 
This equipment also complies with the Class A limits for radio noise emission from digital 
apparatus set out in the Radio Interference Regulation of the Canadian Department of 
Communications. These above rules are designed to provide reasonable protection against such 



 

 

interference when operating the equipment in a commercial environment. If operation of this 
equipment in a residential area causes radio frequency interference, the user, and not ConnectPRO 
Inc. Limited, will be responsible.  
Changes or modifications made to this equipment not expressly approved by ConnectPRO Inc. 
Limited could void the user’s authority to operate the equipment.   
ConnectPRO Inc. Limited assumes no responsibility for any errors that appear in this document. 
Information in this document is subject to change without notice.  
No part of this document may be reproduced or transmitted in any form or by any means, electronic 
or mechanical, for any purpose, without the express written permission of ConnectPRO Inc. 
Limited.  
© 2003 ConnectPRO Inc. Limited. All rights reserved.  
Trademarks  
PS/2 is a registered trademark of International Business Machines Corporation. All other 
trademarks and registered trademarks are the property of their respective owners.  



 

 

2. Introduction  

 
Access and control multiple multi-platform computers from one Keyboard Video Mouse (KVM) 
console with the Multi-Platform CAT5 KVM (CAT5 KVM) system. The CAT5 KVM comes in 8 
and 16 port models. Connect up to 8 computers to the 8 port model, and up to 16 to the 16 port 
model.   

3. Features  

 

• Hot-Swap - disconnect and reconnect computers without rebooting  

• Scan-mode operation with variable time interval  

• 1U Rack mountable   

• Operate the system using an On Screen Display (OSD) or Control software or front panel push 
buttons or keyboard hotkeys  

• Create multi-level cascade arrangements. For example by cascading the CAT5 KVM 16 Port 
model, connect up to up to 256 computers in the system   

• The computers can be placed up to 10m/33ft from the CAT5 KVM  

• Multi-platform — supports PS/2, SUN, and USB computers/servers  

 

4. System components  

 
The CAT5 KVM system consists of:  

• Multi-Platform CAT5 KVM 8 or 16 port  

• Computer Interface Module  (CIMs) – PS/2, SUN, USB  

• CAT5 cables (1.5m provided)  

• RS232 Serial cable  

• Rack mounts for the CAT5 KVM and the CIMs   

• VGA Extender cable  

 
5. Compatibility  

 
The CAT5 KVM is compatible with:  

• PS/2, SUN and USB computers/servers  



 

 

• VGA, SVGA, or XGA monitors  

• DOS, Windows (3X, 9X, 2000, NT4, ME, XP), LINUX, UNIX, HP UX, QNX, SGI, FreeBSD, 
BeOS, Open VMS, Novell 3.12-6  

 

6. The CAT5 KVM system configuration   

 
Figure 1 illustrates the basic configuration of the CAT5 KVM system.  

  

Figure 1 The CAT5 KVM system configuration   

7. The CAT5 KVM models  

 
Figure 2 illustrates the front panel of the CAT5 KVM 16 port model. The 8 port model is the same 
but with only 8 rows of LEDs.  

   
Figure 2 CAT5 KVM front panel  

The figure below illustrates the rear panel of the CAT5 KVM 16 port unit. The 8 port model is the 
same but with only 8 Computer ports.  

  
Figure 3 CAT5 KVM 16 port rear panel  

8. Pre-installation guidelines  

 
• Switch off all computers  



 

 

• Place cables away from fluorescent lights, air conditioners, and machines that are likely to 
generate electrical noise  

• Ensure that the maximum distance between each computer and the CAT5 KVM, does not exceed 
10m/33ft  

 

9. Connecting the CAT5 KVM system  

 
Connect each computer to the CAT5 KVM system using the appropriate CIM and CAT5 cables. 
Figure 4 illustrates the CAT5 KVM system connections with the appropriate CIM connected to a 
PS/2, SUN and USB computer/server.  

  

Figure 4 CAT5 KVM system connections  

The CIMs  

The CIMs draw their power from the computer’s keyboard port (CIM PS/2, SUN) or from the USB 
port (CIM USB).  

Connecting a PS/2 CIM  

Figure 5 illustrates the CIM.  

To connect the PS/2 CIM:  

1. Connect the Screen connector to the computer’s Video card.  

2. Connect the Keyboard connector to the computer’s Keyboard port.  

3. Connect the Mouse connector to the computer’s Mouse port.  



 

 

  
Figure 5 PS/2 CIM  

  

Connecting a SUN CIM  

Figure 6 illustrates the SUN CIM and its connections.  

To connect the SUN CIM:  

1. Connect the Screen connector to the computer’s Video card.  

2. Connect the Keyboard connector to the computer’s Keyboard port.  

   
Figure 6 SUN CIM  

Connecting a USB CIM  

The CIM USB supports Windows 98 SE and later, MAC, SUN and SGI. Figure 7 illustrates the 
USB CIM and its connections.  

To connect the USB CIM:  

1. Connect the Screen connector to the computer’s Video card.  

2. Connect the USB connector to the computer’s USB port.  



 

 

   
Figure 7 USB CIM  

VGA Extender cable  

Where the CIM’s Screen connector won’t reach the computer’s Video card, connect the VGA 
Extender cable to the CIM and then follow the instructions below.  

Connecting the CAT5 cables  

1. Connect one connector to the CIMs RJ45 port.  

2. Connect the other connector to one of the CAT5 KVM’s Computer ports.  

3. Follow the above 2 steps for each computer.  

Connecting the KVM console  

To connect a KVM console to the CAT5 KVM:  

1. Connect the monitor’s connector to the CAT5 KVM’s Monitor port.  

2. Connect the keyboard’s connector to the CAT5 KVM’s Keyboard port.  

3. Connect the mouse’s connector to the CAT5 KVM’s Mouse port.  

10. Connecting the power supply  

 
1. Connect the CAT5 KVM to the power supply using the Power cable provided.   

2. Switch on the computers.   

11. Updating the LEDs   

 
The front panel CPU onputers when you do one of the following:   

• Open the OSD (On Screen Display) – see below   

• Press the 2 front panel Select buttons simultaneously.  

 



 

 

12. Resetting the Switch  

 
To reset the Switch press the 2 front panel Select buttons simultaneously. The CIMs are unaffected 
by this reset.  

Resetting can also be performed through the software – explained later.  

13. Rack mounting the CAT5 KVM  

 
Use the L-shaped brackets and screws provided to mount the CAT5 KVM on a server rack as 
illustrated below.  

   

14. Rack mounting the CIMs  

 
You can attach the CIMs to a server rack or computer using the Velcro strips provided. Or connect 
it using the bracket provided.  

The figure below illustrates the bracket.  

   
  

15. Operating the CAT5 KVM system  



 

 

 
Switch between the connected computers by either   

• The front panel Select buttons  

• Keyboard hotkeys  

• The OSD (On Screen Display)  

 
The OSD is also the place to adjust various settings as explained below.  

When switching computers the illuminated LED of the top bank indicates which computer is 
currently selected.  

16. The keyboard hotkeys  

 
To switch to the next computer forwards press Shift then, +. Release Shift, before pressing +.  

To switch to the next computer backwards press Shift then, -. Release Shift, before pressing -.  

Note! With a US English keyboard you can use the + of the alphanumeric section or of the numeric 
keypad. With a Non-US English keyboard only use the + of the numeric keypad.   

17. The OSD  

 
To display the OSD:   

Press Shift twice. The OSD Main window appears. See Figure 8. Lines with blue text show active 
computers. Lines with grey text show inactive computers.  

The Type column indicates whether a computer “C” or another switch “S” is connected to the port.  

   
Figure 8 The OSD Main window  

18. Navigating the OSD  

 
To navigate up and down use the Up and Down arrow keys.  

To jump from one column to the next (when relevant) use the Tab key.  

To exit the OSD or return to a previous window within the OSD press Esc.  

19. Selecting a computer  



 

 

 
To select a computer:  

1. Navigate to the desired computer line.   

2. Press Enter. The selected computer is accessed. An confirmation label appears showing which 
computer is accessed.  

Note! When the OSD is displayed you cannot select computers using the front panel Select buttons 
or the keyboard hotkeys.  

20. The OSD settings (F2)  

 
Press F2. The OSD Settings window appears see Figure 9.   

   
Figure 9 The Settings window  

Note! When the OSD is password protected (explained below) only the Administrator has 
access to the F2 settings window.  

21. The General settings  

 
With the blue line on the word GENERAL, press Enter. The General settings window appears see 
Figure 10.  

  
Figure 10 The General Settings window  

From this window you can do the following:  

Security  

The OSD comes with an advanced password security system that contains 3 different security 
levels. Each security level has different access rights to the system.  

These levels are as follows:  



 

 

Administrator (Status A)   

 
The Administrator can:  

• Set and modify all Passwords and security profiles  

• Fully access any computer  

• Use all OSD functions  

 Supervisor (Status S)   

 
The Supervisor can:  

• Fully access any computer  

• Access the following OSD functions only –F4 Scan, F5 Tune and F6 Moving the 
Confirmation label.  

 User (Status U)   

 
There are 6 different Users in the CAT5 KVM system. Each User has a Profile set by the 
Administrator that defines the access level to different computers. There are 3 different access 
levels, these are explained on page 17.   

Activating password protection  

By default OSD access is not password protected. Only the Administrator can password-protect the 
OSD or disable password protection.   

To do so:  

1. In the General settings window navigate to the Security line.   

2. Press the Space bar to toggle between Security On and Off. The password box appears.  

3. Type the Administrator’s password (default is “admin”).  

4. Press Enter. The new security status is set.  

Changing the OSD hotkey  

By pressing Shift, Shift the OSD appears. You can replace Shift, Shift with any of the following:  

• Ctrl, Ctrl  

• Ctrl, F11  

• Print Screen  

 
To change the hotkey:  

1. Navigate to the Hotkey line.  



 

 

2. Press the Space bar to toggle between options. To display the OSD in future press the new 
hotkey.  

Autoskip  

With the Autoskip feature, the arrow keys only access the active computer lines on the OSD. When 
Autoskip is Off, The arrow keys access both active and inactive computer lines.  

To change the Autoskip setting:  

1. Navigate to the Autoskip line.  

2. Toggle between the options using the Space bar.  

Serial port  

The Serial port is used for the Control Management program. Serial port On means the program can 
be used.  

To change the Serial port setting:  

1. Navigate to the Serial port line.  

2. Toggle between the options using the Space bar.  

Changing the Keyboard language   

The keyboard is preset to US English, this can be changed to French (FR) or German (DE), as 
follows:  

1. Navigate to the Keyboard language line.   

2. Toggle between the options using the Space bar.  

Editing the Switch name  

You can substitute up to 18 characters in the line. A space constitutes a character. When there is 
more than one switch in the system give each Switch’s Osd a different name.  

22. F7 Defaults  

 
Press F7 to return the OSD to the factory default settings. Note! All changes made will be removed.  

23. The Ports settings  

 
In the Settings window navigate to the Ports line and press Enter. The Ports settings window 
appears see Figure 11.  



 

 

   
Figure 11 Ports Settings window  

Editing the computer name  

In this window you can edit the computer names with up to 15 characters.   

To erase a character:  

Select it and press the Space bar. Blank spaces remain in place of the erased character.  

To erase an entire line:  

Place the cursor at the beginning of the line. Keep the Space bar depressed until the line is erased.  

Keyboard (KB)  

The CAT5 KVM operates with Windows, Linux, HP UX, Alpha UNIX SGI, DOS, Novell, MAC, 
USB or Open VMS.  

By default the keyboard mode is set to PS for Intel based computers.   

For the other systems set the KB column as follows:  

• U1 for HP UX  

• U2 for Alpha UNIX, SGI, Open VMS  

• U3 for IBM AIX  

 

Adding/changing a hotkey (HKEY)  

Cascade the CAT5 KVM by connecting another Multi-Platform CAT5 KVM to a Computer port 
instead of a computer, and then connecting more CIMs to the second Switch. Connect a third and 
fourth Switch in the same way. With the CAT5 KVM 16 Port model, connect up to up to 256 
computers through cascading.  

You must define a hotkey to display the OSD of each Switch. These hotkeys must be different for 
the top and bottom layers. The hotkeys can be any of the choices as set out above on page 14.   

To add/change a hotkey:  

1. On the line to which the Switch is connected, press Tab to jump to the HKEY column.  

2. Toggle between the options using the Space bar.  

24. The Time settings  



 

 

 
In the Settings window navigate to the Time line and press Enter. The Time settings window 
appears see Figure 12.  

   
Figure 12 Time settings window  

  

Scan (SCN) - Label (LBL) - Time out (T/O)  

SCN SCN column, change the scan period.   

LBL - In the LBL column, change the display period of the OSD label showing which computer is 
currently accessed.  

T/O - When password protection is activated you can automatically disable the Management 
keyboard, mouse and screen after a preset time of non-use. Set this Timeout period in the T/O 
column.  

  

To set the above periods:  

1. On the desired line press Tab to jump to the desired column.   

2. Place the cursor over one of the  3 digits and type a new number. Enter a leading zero where 
necessary. For example, type 040 for 40 seconds.  

Typing 999 in the LBL column displays the label continuously. Typing 000 – the label will not 
appear.  

Typing 999 in the T/O column disables the Timeout function. Typing 000 – the Timeout 
function works immediately.  

Typing 999 in the SCNn displays the screen for 999 seconds. Typing 000 – the computer screen 
is skipped.  

25. Users  

 
In the Settings window navigate to the Users line and press Enter. The Users settings window 
appears see Figure 13.  



 

 

   
Figure 13 The Users settings window  

  

There are 3 different access levels. These are:  

• Y – Full access to a particular computer. Plus access to the F4, F5 and F6 OSD functions  

• V –Viewing access only, to a particular computer (No keyboard/mouse functionality)  

• N – No access to a particular computer – A TIMEOUT label appears if access is attempted  

 
To give each user the desired access level:  

1. Navigate to the desired computer line and User.  

2. Toggle between the options using the Space bar.  

26. Security  

 
In the Settings window navigate to the Security line and press Enter. The Security settings window 
appears see Figure 14.  

   
Figure 14 The Security settings window  

The ‘T’ column on the right hand side stands for Type of password.   

There can only be 1 Administrator password, 1 Supervisor password, and 6 User passwords.  

To change a user name or password:  

1. Navigate to the desired line and column.  

2. Type a new user name / password. User authentication is done solely via the password there is no 
security significance to the names.  



 

 

By default the User Profile settings are full access.  

27. The OSD HELP window – F1  

 
To access the HELP window press F1. The HELP window appears, see Figure 15.  

   
Figure 15 The HELP window  

  

Please note! All the functions set out in the Help window are performed from the Main window. 
The Help window is merely a reminder of the hotkeys and their functions.  

28. Scanning computers– F4  

 
Where necessary adjust the scan time in the Time Settings window, see above.  

To activate scanning:  

1. Press Shift twice to open the OSD.  

2. Press F4. Your screen displays each active computer sequentially, with the Scan label appearing 
in the top left corner.  

To deactivate scanning:   

Press F4.  

29. Tuning – F5  

 
You can tune the image of any remote computer screen from the Select Computer  

window.  

To adjust the screen image:  

1. Navigate to the remote computer you wish to adjust.  

2. Press F5. The screen image of the selected computer appears, together with the  

Image Tuning label.  



 

 

3. Adjust the image by using the RightLeft Arrow keys.  

4. When the image is satisfactory, press Esc.  

Note! Picture quality is relative to distance. The further away a remote computer is from the CAT5 
KVM, the lower the image quality, and the more tuning needed. So place the higher resolution 
computers closer to the manager unit.  

30. Moving the label – F6  

 
Position the OSD label anywhere on the screen.  

To position the label from the Main window:  

1. Navigate to the desired computer using the Up and Down arrow keys.  

2. Press F6. The selected screen image and Identification label will appear.  

3. Use the arrow keys to move the label to the desired position.  

4. Press Esc to save and exit.  

31. Using the Control software  

 
As an alternative to the OSD you can operate the CAT5 KVM system with the Control software 
located on the Marketing & Documentation CD. With the OSD you operate the system and view 
the computer screens on the same monitor. The Control software requires 2 monitors 1 for the 
software and 1 to view the computer screens.  

With the Control software you can:  

• View computers  

• Edit OSD settings  

• Save configurations for future use   

• Read configurations from and write configurations to the Multi-Platform CAT5 KVM  

 

32. Control software system requirements  

 

• Pentium 166 or higher computer  

• 16Mb RAM  

• Windows 98, NT4 (SP6), 2000, ME, XP or 2003 server   



 

 

• Free Serial port  

 

33. Connecting the RS232 Serial cable  

 
To run the software, connect the RS232 Serial cable to the computer containing the software, and to 
the CAT5 KVM. See the figure below.  

   
Figure 16 Connecting the RS232 Serial cable  

34. Installing and running the Control software  

 
Note! The CAT5 KVM system must be fully connected BEFORE running the Control software. 
Failure to first connect the system will lead to the software working in demo mode.  

Start the Marketing & Documentation CD and choose Multi-Platform CAT5 KVM Softpack. The 
Multi-Platform CAT5 KVM Softpack window appears.   

To install the software choose Install CAT5 KVM  RS232 Control Software . Once the software 
is installed, a shortcut icon appears on the Desktop  .   

To run the software double-click the icon.  

Or choose Start / Programs / CAT5 KVM RS232 Control / CAT5 KVM RS232 Control.  

To run the software from the CD:  

Choose Run CAT5 Smart switch RS232 Control Software from CD.  

Selecting a Com port  

During the Setup process you will be prompted to choose a Com port. Choose the Com port to 



 

 

which the RS232 Serial cable is connected. Failure to select the correct Com port will result in the 
software running in demo mode.   

Once Setup is complete the Control window appears. See the figure below.  

   
Figure 17 The Control window  

35. Computer icons  

 
Icon  Meaning  

  

Computer is connected and switched on  

  

Computer is switched off or unconnected  

  

Connected and switched on computer with a Local . After remaining idle for the Timeout 
period, it changes to yellow.  

 

When you first open the Control window the software automatically gets the status of the 
CAT5 KVM system, including the security access settings.   

36. Communication Error   

 
If a Communication Error box appears when trying to scan the system – see Figure 18.   

   
Figure 18 Communication Error  

Check that:  

• The RS232 Serial cable is connected to the computer’s and CAT5 KVM Manager’s serial 
ports.  

• The Com Port settings in Options / Com Port are set correctly. After changing the Com port 
exit and re-enter the Control software.  



 

 

 

37. The View menu  

 
From the View menu choose to display:  

• All computers, or only active switched on computers.  

• The Legend   

• The toolbar  

 

38. Selecting a computer  

 
To select a computer:  

Click on the computers icon. The system switches to that computer. The connected icon appears 

with a red background  . Control and monitor the selected computer from the keyboard and 
mouse connected to the CAT5 KVM.  

39. The toolbar buttons  

 
The toolbar buttons are explained below.  

40. Get Status  

 
If for whatever reason there is a break in communication between the Control software and the 

CAT5 KVM system, click   to get the current status of the computers in system. The 
system automatically updates the status before every switching.  

41. Read Configuration  

 
To see the current settings of the entire CAT5 KVM system (names, scan settings etc.) click 

 . All current settings are received. You view the computer settings from the 
Control window and other settings from the Edit menu – discussed below.  

42. Write Configuration  

 
With the Control software you can make changes to all OSD settings. You can then save these 
configurations in a file to use in the future by selecting SaveSaveAs from the File  menu.   

Note! SaveorSaveAs will have no affect on the OSD .   



 

 

To change the OSD settings you must press   or choose Write Configuration 
from the File  menu after making changes. The changes will then be sent to the CAT5 KVM 
Manager, and the OSD will reflect these changes.  

Renaming a computer  

To rename a computer:  

1. Type the new name in the box below the computer icon.  

2. Click   to send the new name to the CAT5 KVM system.   

Or click SaveSaveAs from the File  menu to save the change in a file and not alter the OSD names.  

The Edit menu  

You can edit all OSD fields. Edit the following from the Edit menu.  

• Logo  

• Passwords  

• Settings  

 

Logo and Passwords  

You can edit the logo that appears at the top of the OSD window. You can also edit the names and 
passwords for the Administrator, Supervisor and 6 Users.  

1. Edit the Logo and Passwords by choosing them from the Edit menu. See figures below.   

  
Figure  19 The logo  

  
Figure  20 The names and passwords  

 
2. Make the desired changes.  

3. Click OK.  

Settings  

Choose Settings from the Edit menu. The Computers’ Properties box appears. See Figure 21.  



 

 

   
Figure 21 The Settings box  

Here you can edit all the data that can be edited in the OSD. This includes:  

Scan times, Confirmation label display time, Timeout, mouse type, keyboard type, User access, 
password mode, Autoskip mode, keyboard mode – Display hotkey.  

To edit a setting:  

1. Select the desired computer or group of computers.  

2. Make the desired changes.  

3. Check the Select box next to the changed setting.  

4. Click OK.  

Single computer settings  

To see all the settings of a single computer right click on the computer icon. The settings appear as 
in the figure below.   

Note! There is no Select box to check.  

   
Figure 22 The single computer Settings box  

43. Loading a saved configuration  

 
To load a saved configuration:  

From the File menu choose Open.  

44. The factory default settings  



 

 

 
To view to the factory default settings:  

From the File menu choose New.  

45. Reminder!   

 
All changes done with the Control software are only reflected in the OSD AFTER pressing 

 .    

46. Password protection  

 
When the CAT5 KVM system is password protected, the Control software behaves in exactly the 
same way as the OSD. You must type in the required password to access the Control software. The 
access you gain depends on the security status – exactly as with the OSD.   

To change the security access, close and reopen the Control software, and type in the different 
password.  

Administrator (Status A)   

 
The Administrator can:  

• Set and modify all Passwords and security profiles  

• Fully access any computer  

• Use all functions  

 Supervisor (Status S)   

 
The Supervisor can:  

• Fully access any computer  

• Scan computers.  

 User (Status U)   

 
There are 6 different Users in the CAT5 KVM system. Each User has a Profile that defines the 
access level to different computers. There are 3 different access levels. These are:  

• Y – Full access to a particular computer  

• V –Viewing access only, to a particular computer (No keyboard/mouse functionality)  

• N – No access to a particular computer  



 

 

 
The Administrator defines the desired access levels of each User Profile. This is done in the Setting 
box. By default the User Profile settings are full access.  

47. Upgrading the CAT5 KVM firmware  

 
With the CAT5 KVM Update software program you can upgrade the firmware for the:  

• OSD  

• Manager  

• CIMs  

 
CAT5 KVM Update enables you to add new features and fix bugs in a quick and efficient manner.  

You can install the Multi-Platform CAT5 KVM Update on any computer, even one not part of the 
CAT5 KVM system.  

The CAT5 KVM Update software and latest firmware is on the Marketing & Documentation CD.   

To obtain the latest firmware for your system go to  www.ConnectPRO.com  .  

48. System requirements for the CAT5 KVM Update software  

 
• Pentium 166 or higher with 16 MB RAM and 10 MB free Hard Drive space.  

• Available  Serial port.  

• Windows 98, 2000, ME, XP or Windows NT 4.0 SP (service pack) 3 or later.  

 

49. Connecting the CAT5 KVM System  

 
To update the firmware the CAT5 KVM system must be connected and switched on.   

50. Connecting the RS232 Serial cable  

 
To run the software, connect the RS232 Serial cable to the computer containing the software, and to 
the Multi-Platform CAT5 KVM. See page 21.  

51. Installing the software   

 
To install the Multi-Platform CAT5 KVM Update software:  

1. Insert the Marketing & Documentation CD. The CD menu runs automatically.  



 

 

2. Choose Multi-Platform CAT5 KVM Softpack.  

3. Either run the Multi-Platform CAT5 KVM Update software straight from the CD or install it 
on the computer’s hard drive and run it from there.  

52. Starting and configuring the CAT5 KVM Update  

 
1. Start the CAT5 KVM Update software. The CAT5 KVM Update window appears. See Figure 

23.  

  
Figure 23 The Multi-Platform CAT5 KVM Update window  

The table below explains the functions of the buttons and boxes in the Multi-Platform CAT5 KVM 
Update window.  

Button or Box  Function  

  
Selects all CIMs  

  
Unselects selected CIMs  

  
Starts firmware download  

  
Displays the firmware version number  

  
Displays the hardware version number 

  
Cancels selected function  

  
System time  

  
Displays download status   

  
Name of Update file  

 

2. From the Options menu choose Com Port. The Com Port box appears.   



 

 

 See Figure 24.  

  
Figure 24 The Com Option box  

3. Choose an available Com Port and click OK.  

Note! The RS232 Serial cable must be connected to the selected Serial port.  

53. Verifying the version numbers  

 
Before upgrading the firmware, you must first verify which firmware and hardware versions you 
have.   

The OSD version number  

To verify the OSD version number:  

1. Open the Multi-Platform CAT5 KVM Update program.   

2. In the Switch Unit box, check the OSD option. See Figure 23.  

3. Click  . The version number appears in the Switch box.   

The H/W Version button is grayed out, as there is no hardware relevant to the OSD.  

The CAT5 KVM Manager version number  

To verify the CAT5 KVM version number:  

1. Open the Multi-Platform CAT5 KVM Update program.   

2. In the Switch Unit box, check the CAT5 KVM  Manager option.  

3. Click  . The firmware version number appears in the Switch Unit box.  

4. Click  . The hardware version number appears in the Switch Unit box.  

Verifying the CIM version number  

Before you can check a CIM, you must uncheck the Switch Unit box options.  

To verify the CIM version number:  

1. Open the Multi-Platform CAT5 KVM Update program.   

2. Check one or more or all of the CIMs.  

3. Click  . The firmware version number appears after the CIM number.  



 

 

4. Click  . The hardware version number appears after the CIM number.  

When “Not responding” appears, there is no computer connected, or it is switched off.  

54. Obtaining new firmware  

 
Download the latest firmware for your system from www.ConnectPRO.com  

55. Updating the firmware  

 
Warning!  

Never switch off any computer connected to the CAT5 KVM system during the updating process.  

To update the firmware:  

1. Open the Multi-Platform CAT5 KVM Update program.   

2. In the Multi-Platform CAT5 KVM Update window, check the appropriate option in the Switch 
Unit box or the desired CIM.  

3. From the File  menu, choose Open. The Open box appears. See Figure 25.  

4. Navigate to the folder that contains the firmware update file. You may only see the files that 
match the file selection mask.  

   
Figure 25 The Open box  

5. Open the file.  

6. Click Start. The Multi-Platform CAT5 KVM Update flashes the firmware. On completion the 
firmware version number appears.  

7. Check that the updated version number is correct by pressing  .  

Firmware Update generates one log file per session that displays a chronological list of actions. 
You can read the log file in any ASCII text editor. The log file is located in the Windows directory.  

56. Reset   

 
Reset the software for the CAT5 KVM Manager or CIMs when for example the unit hangs or when 



 

 

the mouse fails to work properly. Resetting is done via the Serial port, and avoids the need to shut 
down the computer.  

NOTE! The Reset function does not affect the parameters of the unit settings.  

Resetting the Switch or CIM units  

To reset the Switch or CIM units:   

1. For the Switch, check the Multi-Platform CAT5 KVM option in the Switch Unit box.   

For the CIMs, check one or more CIMs in the CIM Units  box.  

2. From the Options menu choose Advanced / Reset. The units reset. The system should now be 
operational.  

57. Troubleshooting tips  

 
When using Firmware Update software you may sometimes get a Communication Error message.  

When updating a unit and a Communication Error message appears, do the following:  

1. Check that the RS232 Serial cable’s RS232 connector is connected to the Switch’s 
Communication port.  

2. Check that the RS232 Serial cable’s DB9F connector is connected to the DB9M Serial port on 
the CPU’s rear panel.  

3. Restart the download process.  

Electricity failure   

If the electricity fails while updating the CAT5 KVM firmware, do the following:  

If the electricity fails during the firmware update of the Switch, a Communication Error message 
appears. Simply resume the firmware update by opening the folder that contains the firmware 
update file and continue from there.  

If the electricity fails during the firmware update of the CIMs a Not Responding or Upgrade 
Error message appears. Restart the upgrade from the beginning.  

58. USB SUN Combo keys  

 
The connected PS/2 keyboard does not have a special SUN keypad to perform special functions in 
the SUN Operating System environment. So when a CIM USB or SUN is connected to a SUN 
computer, the CIM emulates these SUN keys using a set of key combinations called Combo keys. 
See the table below.  

SUN key  Combo key  

Stop  Left Ctrl + Alt + F1  

Props  Left Ctrl + Alt + F3  

Front  Left Ctrl + Alt + F5  

Open  Left Ctrl + Alt +F7  



 

 

Find  Left Ctrl +Alt + F9  

Again  Left Ctrl + Alt + F2  

Undo  Left Ctrl + Alt + F4  

Copy  Left Ctrl + Alt + F6  

Paste  Left Ctrl + Alt + F8  

Cut  Left Ctrl + Alt + F10  

Help  Left Ctrl + Alt + F11  

Compose  Application key or Left Ctrl + Alt + Keypad *  

Crescent  Scroll Lock  

Volume Up  Left Ctrl + Alt + Keypad –  

Volume Down  Left Ctrl + Alt + Keypad + 

Mute  Left Ctrl + Alt + F12  

Sun Left ? key  Left Windows key  

Sun Right ? key  Right Windows  key  

Alt-Graph  Right Alt or Alt Gr  

Stop A  Left Ctrl + Alt +1  

 
  

  

59. Technical specifications  

 
Operating Systems  DOS, Windows (3X, 9X, 2000, NT4, ME, XP)  

LINUX, UNIX, QNX, SGI, FreeBSD, BeOS, Open VMS, Novell 3.12-6  

Local Mouse Driver  PS/2, wheel mouse  

Resolution  1600x1200@75Hz  

Transmission distance  Up to 10m/33ft   

 
  
Multi-Platform CAT5 KVM    

Dimensions – 8/16  266.5 x 110.5 x 41.3mm / 10.47 x 4.35 x 1.62in  

Weight – 8/16 port  Product – 1Kg / 2.2lbs  

Shipping – 1.95Kg / 4.22lbs  

Power supply – 8/16 port  Internal switching 85-260 VAC 50 / 60 Hz  

Connections    



 

 

System  

Local KVM   

RJ45  

RJ11  

HDD15/MinDin6/MiniDin6  

Operating temperature  0ºC to 40ºC/32ºF to 104ºF  

Storage temperature  -40ºC to 70ºC/-40ºF to 158ºF  

Humidity  80% non-condensing relative humidity  

 
  
CIMs  PS/2  USB  SUN  

Connections        

VGA   

Keyboard/Mouse  

System  

HDD15  

MiniDin6  

RJ45  

HDD15  

USB  

RJ45  

HDD15  

MiniDin6  

RJ45  

Power  From computer’s  From USB port  From computer’s  

Product weight  107g  

Shipping weight   300g  

Dimensions  91 x 41 x 24mm / 3.58 x 1.61 x 0.94in  

 
  

  
   

   

 


